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Before using this information, be sure to read the general information under the “Notices” section 

on page 36. 
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Welcome 
 

Welcome to the DOORS Walkthrough for IBM Rational Dashboard! 

 

IBM Rational Dashboard brings software management best practices within reach of every 

organization and every manager.  Manage requirements, schedule, budget, quality, configuration 

management and size in one place; keeping total control of the drivers that keep projects on time 

and within budget.   

 

IBM Rational Dashboard spans the gap between the management process desired and the one 

currently in place.  Focus on managing by exception using IBM Rational Dashboard alerts, 

analysis, graphical displays and drillable views that provide all the information needed to make 

well-informed decisions quickly.  Using a web-based interface and intelligent integrations to 

software life cycle tools, IBM Rational Dashboard delivers industry best practices ready to be 

applied.  Finally, IBM Rational Dashboard checks project compliance with industry standards and 

unit templates, ensuring a course to success.  
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Data Collection Overview 
 
Before beginning the integration to a data source, it is important to understand the key elements 

that allow the portal to gather and display data from your data.  

 

Data in the Portal is gathered by the Collector, configured by the Interfaces, organized by 

Information Needs and analyzed in the Organization Tree. 

 

 

 
 

The Collector (Windows based executable) - Gathers data from outside sources and stores it in 

the Transform database.  

 Outside Data Sources include: IBM Rational DOORS, IBM Synergy, IBM Change, IBM 

Rational ClearQuest, Microsoft Project, Oracle Databases, Microsoft SQL Databases, 

Microsoft Access, Microsoft Excel, ODBC, CSV, and HP Quality Center.  

 The Transform is a MS SQL Database table located in the Dashboard_Transform 

database.  It stores current and historical data collected from Outside Data Sources. 
 

Interfaces (From the Collection tab in the Portal) – Allow users to define and organize data 

collected by the Collector.  Interfaces are defined using three subtabs: General, Fields and 

Queries. 

 The General tab includes the type of data being retrieved from the Outside Sources as 

well as the name of the database that will be used to store the data. 

 The Fields tab defines the field sets of data that are being retrieved as well as the table 

name where information will be stored in the Transform. 

 The Queries tab indicates the SQL queries that will be run against the Transform to 

produce data points for Graphs. 
 

Information Needs (From the Library tab in the Portal) – Allow users to define graphs to display 

the collected data. 

 Graphs contain Series that are used to plot data against time/events. 

 Series are associated with Queries defined in Interfaces to determine which data to plot. 

 Information Needs can be used by one or more interfaces. 
 

Organization Tree (From the Status tab in the Portal) – Allows users to display and analyze data 

in Graphs which are defined in Information Needs. 

 Folders and Units provide structure for the Organization Tree. 

 Units can contain one or more Information Needs. 
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IBM Rational DOORS Sample Walkthrough 

 

This sample describes the steps to be performed in tool needed to configure and collect data from 

IBM Rational DOORS.  This sample walks a new user through all required steps needed to see 

graphs with data points populated with information from IBM Rational DOORS.  

There are four areas that will be covered through this walkthrough: 

 Set up IBM Rational DOORS modules for collection 

 Portal Configuration: 
o Examine/Configure an Interface in the Portal 
o Examine/Configure an Information Need 
o Assigning Schedules to a Template 
o Setup a Unit with Information Needs (or use a template) 

 Collector Configuration 
o Configure the Collector 
o Run a collection 
o Check/Resolve any collection errors/problems 

 Unit Configuration 
o Check for collected items in the Portal and assign them to Units 
o Refresh the Unit 
o View collected data graphs in the Portal 
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Configuring IBM Rational DOORS 

 

Before the Portal can collect data from your IBM Rational DOORS modules, the modules you wish 

to collect data from will need to be configured for use with the Portal.  There are two attributes 

you will need to define on the IBM Rational DOORS modules from which you wish to collect data. 

The first attribute, the Collect attribute, determines if the module should be considered for 

collection.  You may name it anything you wish (the default is DashboardCollect), and it must be a 

module attribute of Boolean type.  You will need to create this attribute and set it to “True” in all 

modules from which you wish to collect.  If you will be collecting data from all DOORS modules 

you should set the value of the Collect attribute to “True” when you are creating the attribute. 

The second attribute, the Type attribute, identifies which Interface is used to collect for a 

DOORS module.  You may name it anything you wish (the default is DashboardType), and it must 

be a module attribute of string type.  You will need to create this attribute and set it to “Module” 

in all modules from which you wish to collect.  The “Type identifier” in the DOORS Requirements 

Interface that is shipped with the Portal is set to “Module”.  The Type identifier enables you to 

collect different information from different sets of DOORS modules at the same time.  You can use 

a value other than Module, as long as there is an interface defined with that Type Identifier.  If 

you will be collecting data from all DOORS modules you should set the default value of the Type 

attribute to “Module” when you are creating the attribute. 

Both attributes must be configured for any DOORS modules that are to be included in the Portal 

data collection.  
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Configuring the Portal 
 

The Portal provides the user the ability to describe which data to collect, how to analyze it and 

then how to display it.  Before information can be analyzed or displayed, the Portal must be 

configured to collect the information from IBM Rational DOORS. 

Verifying the Interface in the Portal 

 

Upon opening the application, the Portal defaults to the Status page.  The first step is to verify the 

Interface.  Select the Collection tab, and then click on the Interfaces option on the left hand 

side. 

 

From the Interfaces List, click on the edit button to open the DOORS Requirements interface.   
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The interface will open to the general tab.  This is where all the information about what is being 

collected is stored.  This specific interface is a default interface for IBM Rational DOORS.  You will 

notice that a short description has been entered and the Transform Server has been selected as 

the Database.  You will also notice the Type Identifier set to “Module”.  This value is how the 

Collector knows what to collect from a specific module in DOORS.  This is the value that you put in 

the Dashboard Type attribute that you added to DOORS.  Different interfaces may have different 

type identifiers so that you are able to collect different information from different modules. 

 

 

Next, click on the fields tab. 
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Setting up the Fields 
 

The information entered in the fields tab of the Interface defines the information that will be 

collected and where it will be stored.  The list of sets (each containing a group of fields) and the 

database table where the information will be stored is located on the left section of the screen.  A 

list of default fields, which are being collected by the Portal, is located on the right hand section of 

the screen.  The list of fields that is displayed changes based on the set selected from the List of 

Sets drop down menu.  These fields are the default values that all of the graphs will use to 

display the data.   

Check the list of Fields for attributes that do not exist in your DOORS database.  If there is a field 

in the list that is not in your DOORS database, you have three options.  First, you could add the 

field to your DOORS modules.  Each field helps to create different graphs within Dashboard.  The 

second option is to click the “Do not collect from source?” box for each field that you do not have 

in your database.  This will allow you to keep a list of the default field values for possible use 

later.  The final option is to delete the field(s) from the list.  The second option is recommended.  

 
 

 

If you need to modify the list of attributes, you will potentially have to change the queries, and 

you will definitely have at least one graph that will not show data.  The most common omission is 

the “Obj Type” attribute.  This field is used in most of the queries, and if this is an attribute that 

you do not have, you will need to change the queries.  The example below is how you would need 

to change the “Requirements Added” query to reflect a database that didn’t have the “Obj Type” 

attribute. 

Next, click on the queries tab. 
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Modifying the Data Queries 
 

The Query tab will list all of the queries assigned to the Interface.  These queries are used to 

count and quantify the data that is collected. 

 

 
 

 

Clicking the edit button by a query in the main list will open the Edit Query page and allow the 

user to edit the selected query.  Edit the “Requirements Added” query by clicking the edit button 

next to it. 
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Below is the Edit Query page for Requirements Added.  There are two options available when 

modifying a query: Query Builder and Query Edit. 

 

 
 

To modify this query, click on the Query Edit button.   

 

 
 

The Edit Query tab has a text field where the SQL statements can be entered, modified or 

deleted.  You can place your cursor anywhere in the text field to add or modify the query.  In this 

instance, the last case is the one that needs to change.  Highlight and delete it. 

Next, type in the string “obj_heading IS NOT NULL”.  This will bring back all requirements from 

your database.  Be sure to save your changes. 
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Similar changes would need to be made to other queries depending on what is in your DOORS 

database. 
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Verifying the Information Need 

 

This step is optional, as no changes need to be made in the Information Need to help the Collector 

run.  You can familiarize yourself with the graphs for which you will see data in the future.  To see 

the Information Needs, click on the Library tab of the Portal. 

There are two information needs that are setup to work with DOORS automatically.  They are 

“Requirements Progress” and “Requirements Stability”.  

 

Let’s take a look at Requirements Stability.  This Information Need shows the stability and 

volatility of various requirements. 
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The information need display will show the general tab.   

 

Selecting the graphs tab will list the graphs associated with the selected information need.  In 

the sample below, Requirements Stability has three graphs defined.  The various graph 

descriptions and series for each of the listed graphs can be edited here.  When the Information 

Need is added to a unit, the graphs are applied to the data. 
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Assigning Interface Queries to a Library Series 
 

To enable data to be populated in a series, each series must have one or more interface queries 

associated with it.  Once a query is associated with a series, the query is run after data collection 

to provide a data point for the series.  Because a graph in the library is not specific to one 

interface (that is, a graph may have more than one interface that can provide data for it), you 

may select multiple interface queries for one series.  So, you may assign a query from more than 

one interface to the same series in the Library.  When the graph (that contains the series) is 

created in a Unit, the associated interface query is used.  

For series with a data source of single-series or multi-series, you will see the number of Interface 

queries that have been assigned, and you can click on the “Select Queries” button to assign 

queries.  If the Select Queries button is not enabled, make sure the source is single-series or 

multi-series (as appropriate) and then press the Save button.  To simplify the process, the Portal 

provides you with the ability to either 1) assign series to queries or 2) assign queries to series.  

You can access this from either the Library Graph page (see next image) or the queries sub-tab in 

the Edit Interface page.  

 

The Assign Series to Queries page allows you to assign one of more queries to a series in the 

Library.  This page has two sub-tabs described below.  Once you are done with the assignment, 

use the breadcrumbs at the top of the page to return to previous page.  
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On the “to query” subtab, you may select a series from the Library (select an information need 

and then a graph/series from the drop downs) and then review a list of Interface queries, if any, 

that have been assigned to the series.  You may select an interface from the (lower) dropdown, 

and then assign one of the Interface queries to the currently selected series.  This subtab is 

designed to review all the interfaces that a single series has been assigned to.  

 

Notice in the image above that the Requirements Total series from the Requirements Stability 

information need is selected and has one query assigned to it.  
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On the “to series” subtab, you may select an information need and interface and then assign or 

un-assign the series to queries as needed.  This subtab is designed to help assign all the queries 

in an interface at one time to the series in one information need.  Below, the “Requirements 

Added” query from the DOORS Requirements interface has been assigned to the “Added 

Requirements” series of our new graph.  Notice that the button on the appropriate column (below) 

now says “Unassign” indicating that has already been assigned. 

 

When you have finished assigning queries to a series, or reviewing them, you use the breadcrumb 

to return to the previous page. 
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Setup a unit with the DOORS Template 

 

Once everything is set up correctly for the collection, the next step is to configure the Status tab 

to show the data results.  A unit can be created for each project to display the data results and 

status for that project. 

   

To start, click on the Status tab.  To add a unit, click on the edit subtab to organize the data tree 

to include information on a project or projects.  Create a folder, or use an existing one, and then 

add a unit. 

To add a unit, click the add unit button above the tree.  On the right hand side of the screen, 

enter a Title, Owner, Start Date and End date for the Unit.  Select the DOORS Template from 

the drop down template list.  In the sample below, we added a new Unit to the Samples Folder 

and assigned the DOORS Template. 
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After you click the add button, the new unit will appear in the Status tree. 

 

With the Portal configuration complete, you are ready to configure your Collector and collect data. 
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Configuring the Collector 

Open the Collector using Start > Programs > IBM Rational > IBM Rational Dashboard > 

Dashboard Collector. 
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Verify Connection to Web Services 

 
The Collector uses the Web Services to communicate with the Portal.  To verify your connection to 

Web Services, click File, Options from the menu bar.  By default the Web Services URL is set to: 

http://localhost/DashboardWS 

If you are running the collection from the server that is running the Portal then “localhost” will 

work fine.  If you are running the collection from a machine other than the Portal server you will 

need to change the “localhost” part of the URL to the name of the server running the DataDrill 

EXPRESS Portal.  Be sure to click the “Apply” button if you make any changes. 

 

Click the test button to test the connection.  If, after pressing the "test" button, you receive an 

error or warning message, review the message and your web services configuration to correct the 

problem.  The web services configuration information is contained in the web.config in the Web 

Services folder.   
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Add a Source 
 

Choose Sources/add from the left menu.  Select IBM Rational DOORS as the Tool, and give your 

source a name.  You will notice a drop down list of Interfaces below the Tool selection.  This is 

used for many sources to delineate between different instances of a tool and to let the Collector 

know which Interface to use when collecting from a specific source.  For DOORS, this box is 

grayed out because that delineation is made in setting up the Interface (see section on 

Configuring the Portal for more information).  Click the add button. 
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The setup for IBM Rational DOORS requires some basic login information as well as some Portal 

specific information. 

 
 

The "Path to client" is the location where IBM Rational DOORS client is installed on the local 

machine.  Click the button to the side to browse for the file on the computer.  The "User name" 

and "Password" should be a DOORS user who has access to all of the projects and modules from 

which data needs to be collected.  The "Database" is the port number and the server name in the 

format <port number>@<server> of the DOORS database. 

 

The "Collect attribute" and "Type attribute" are the two attributes that need to be added to the 

DOORS database as module level attributes.  The Collector will only collect those modules that 

have the Collect Attribute set to true.  The Type Attribute helps to define which Interface will be 

used to collect data from a module.  Both of these values should match the attributes that were 

added in the Configuring DOORS section. 

 
Be sure to save your settings by clicking the save button in the bottom left corner.   
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Running a Collection 
 

Once you’ve saved your configurations, you’re ready to run your collection.  Go to the control link 

in the Collection section.  Click the radio button for One Source and select your source from the 

drop down on the right.  Below the drop down, select “Specified Date” and choose a date that is a 

valid collection date in a period in the schedule you are using for the unit.  This will allow you to 

see data in your graphs automatically.  See the Help files for more information about how 

schedules affect the Collector. 

 

Once you’ve picked your source and your date, click on the start button.   
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The Collection Progress page will appear and you will be able to track your collection as it runs.  

You will see in the details on the bottom the number of items and containers that were found 

and see how far the collection has progressed. 

 

Once your collection finishes, the summary box at the top of the collector will tell you information 

about the collection itself, how long the collection took, how many items were collected, how 

many rows were inserted into the database table(s) and how many errors were encountered, if 

any. 
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If your collection has errors, you can click on the “View Log File” link at the bottom of the 

progress page.  This will open the log file.  (The log can also be accessed with the File menu.)  

This log file gives you information on why a module may not have been collected.  You also might 

notice that the number of found items is greater than the number of items completed.  This is 

most likely caused by finding containers (which are folders for DOORS), and unless there is a 

report of errors, everything collected correctly.   

 
 

The next step is configuring the Unit. 
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Configuring the Unit 

Assigning Collected Items 

Once you have run your collection without errors, you are ready to add your Items to your Unit.  

Go back to the Status page and click on the edit subtab.  Click on the Unit that you created 

earlier.  On the right hand side, click on the by source subtab.  From the drop down menus, 

choose your Collector and the interface that you are using to collect.  When you’ve selected those 

options, click on the show button.  In the list below you will see a list of all of the items that 

have been collected.     
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Click on the items that you want to add to this unit and then click on the assign button on the 

right hand side. 

 

 

On the left hand side of the page, you will see a list of items that are Assigned Items.   

 

Now all you have to do is refresh the unit and you will see data in the graphs. 
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Refreshing the Unit 

 

While on the Status tab, click on the view subtab and select your unit from the tree on the left 

hand side.  On the right hand side of the page, click on the Graph button, . 

 

In the subsequent Unit Status page, you will see an empty GANTT chart with your items listed 

along the side.  From there, click on the Unit Properties link under the Definition section. 

 

Next, click on the refresh button in the center of the page.  This will let you refresh the data for 

all of the Items and their graphs over a period of time. 
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On the Refresh page, you need to choose the dates for refreshing the graphs.  Since you’ve run a 

collection for only one date, you’d only need to refresh over that date.  So if, for example, you ran 

your collection for March 27th, you would want to refresh over that date.   

In this example, the refresh runs from March 22nd to March 29th, but it could be any span of dates 

that include March 27th. 

 

After you have selected your refresh dates, click the refresh button.  The Status box below will 

tell you when the refresh has completed.  To return to your unit, use the bread crumbs or the 

cancel button.  The save button will create a log file with the information in the Status box.  This 

is useful if there were errors during a refresh. 
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View Data in the Portal 
 

Now you are ready to see your data.  Once back on the status page in your Unit, select a 

managed item in the Dashboards panel to view.  You should see a data point in your graphs for 

the date that you ran the collection.   
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Contact Information 
  

This chapter contains the following topics: 

 

 Contacting IBM Rational Software Support 

 

 Prerequisites 

 

 Submitting problems 

 

 Other information 

 

 

Contacting IBM 

Rational Software 
Support 

If the self-help resources have not provided a resolution to your problem, you 

can contact IBM Rational Software Support for assistance in resolving product 

issues.  

 

Note: If you are a heritage Telelogic customer, you can go to 

http://support.telelogic.com/toolbar and download the IBM Rational 

Telelogic Software Support browser toolbar. This toolbar helps 

simplify the transition to the IBM Rational Telelogic product online 

resources. Also, a single reference site for all IBM Rational Telelogic 

support resources is located at 

http://www.ibm.com/software/rational/support/telelogic/ 

 

 
Prerequisites 

To submit your problem to IBM Rational Software Support, you must have 

an active Passport Advantage® software maintenance agreement. Passport 

Advantage is the IBM comprehensive software licensing and software 

maintenance (product upgrades and technical support) offering. You can 

enroll online in Passport Advantage from 

http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html. 

 

o To learn more about Passport Advantage, visit the Passport Advantage 

FAQs at 

http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_ 

quickguides.html. 

o For further assistance, contact your IBM representative. 

To submit your problem online (from the IBM Web site) to IBM Rational 

Software Support, you must additionally: 

o Be a registered user on the IBM Rational Software Support Web site. For 

details about registering, go to http://www-

01.ibm.com/software/support/. 

o Be listed as an authorized caller in the service request tool. 

http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_%20quickguides.html
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_%20quickguides.html
http://www-01.ibm.com/software/support/
http://www-01.ibm.com/software/support/
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Submitting 
Problems 

To submit your problem to IBM Rational Software Support: 

 

1.   Determine the business impact of your problem. When you report a 

problem to IBM, you are asked to supply a severity level. Therefore, you 

need to understand and assess the business impact of the problem that 

you are reporting. 

Use the following table to determine the severity level. 

 

Severity Description 

1 The problem has a critical business 

impact: You are unable to use the 

program, resulting in a critical 

impact on operations. This condition 

requires an immediate solution. 

2 This problem has a significant 

business impact: The program is 

usable, but it is severely limited. 

3 The problem has some business 

impact: The program is usable, but 

less significant features (not critical 

to operations) are unavailable. 

 4 The problem has minimal business 

impact: The problem causes little 

impact on operations or a 

reasonable circumvention to the 

problem was implemented. 

 

2.   Describe your problem and gather background information, When 

describing a problem to IBM, be as specific as possible. Include all 

relevant background information so that IBM Rational Software Support 

specialists can help you solve the problem efficiently. To save time, know 

the answers to these questions: 

o What software versions were you running when the problem 

occurred? 

To determine the exact product name and version, use the option 

applicable to you:  

o Start the IBM Installation Manager and select File > View 

Installed Packages. Expand a package group and select a 

package to see the package name and version number.  

o Start your product, and click Help > About to see the offering 

name and version number. 

o What is your operating system and version number (including any 

service packs or patches)?  

o Do you have logs, traces, and messages that are related to the 

problem symptoms?  



 

© Copyright IBM Corp. 2004, 2009   

 

34| 

o Can you recreate the problem? If so, what steps do you perform 

to recreate the problem?  

o Did you make any changes to the system? For example, did you 

make changes to the hardware, operating system, networking 

software, or other system components? 

o Are you currently using a workaround for the problem? If so, be 

prepared to describe the workaround when you report the 

problem. 

3.   Submit your problem to IBM Rational Software Support. You can submit 

your problem to IBM Rational Software Support in the following ways: 

o Online: Go to the IBM Rational Software Support Web site at 

https://www.ibm.com/software/rational/support/ and in the Rational 

support task navigator, click Open Service Request. Select the 

electronic problem reporting tool, and open a Problem Management 
Record (PMR), describing the problem accurately in your own words. 

For more information about opening a service request, go to 

http://www.ibm.com/software/support/help.html 

You can also open an online service request using the IBM Support 

Assistant. For more information, go to http://www-

01.ibm.com/software/support/isa/faq.html. 

o By phone: For the phone number to call in your country or region, 

go to the IBM directory of worldwide contacts at 

http://www.ibm.com/planetwide/ and click the name of your country 
or geographic region.  

o Through your IBM Representative: If you cannot access IBM 

Rational Software Support online or by phone, contact your IBM 

Representative. If necessary, your IBM Representative can open a 

service request for you. You can find complete contact information for 
each country at http://www.ibm.com/planetwide/. 

 

If the problem you submit is for a software defect or for missing or inaccurate documentation, 

IBM Rational Software Support creates an Authorized Program Analysis Report (APAR). The 

APAR describes the problem in detail. Whenever possible, IBM Rational Software Support 

provides a workaround that you can implement until the APAR is resolved and a fix is 

delivered. IBM publishes resolved APARs on the IBM Rational Software Support Web site daily, 

so that other users who experience the same problem can benefit from the same resolution. 

 

 
Other 

Information 
For Rational software product news, events, and other information, visit 

the IBM Rational Software Web site on 

http://www.ibm.com/software/rational/. 

http://www.ibm.com/planetwide/
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Notices 
 
This information was developed for products and services offered in the U.S.A.  IBM may not offer 

the products, services, or features discussed in this document in other countries. Consult your 

local IBM representative for information on the products and services currently available in your 

area. Any reference to an IBM product, program, or service is not intended to state or imply that 

only that IBM product, program, or service may be used. Any functionally equivalent product, 

program, or service that does not infringe any IBM intellectual property right may be used 

instead. However, it is the user's responsibility to evaluate and verify the operation of any non-

IBM product, program, or service.   

IBM may have patents or pending patent applications covering subject matter described in this 

document. The furnishing of this document does not grant you any license to these patents. You 

can send written license inquiries to: 

 

IBM Director of Licensing 

IBM Corporation 

North Castle Drive 

Armonk, NY 10504-1785 

U.S.A. 

 

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM 

Intellectual Property Department in your country or send written inquiries to: 

 

IBM World Trade Asia Corporation 

Licensing 

2-31 Roppongi 3-chome, Minato-ku 

Tokyo 106-0032, Japan 

 

The following paragraph does not apply to the United Kingdom or any 

other country where such provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS” 

WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT 

LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR 

FITNESS FOR A PARTICULAR PURPOSE. 

 

Some states do not allow disclaimer of express or implied warranties in certain transactions. 

Therefore, this statement may not apply to you.   

 

This information could include technical inaccuracies or typographical errors.  Changes are 

periodically made to the information herein; these changes will be incorporated in new editions of 

the publication. IBM may make improvements and/or changes in the product(s) and/or the 

program(s) described in this publication at any time without notice. 
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Any references in this information to non-IBM Web sites are provided for convenience only and do 

not in any manner serve as an endorsement of those Web sites. The materials at those Web sites 

are not part of the materials for this IBM product and use of those Web sites is at your own risk.  

IBM may use or distribute any of the information you supply in any way it believes appropriate 

without incurring any obligation to you.   

 

Licensees of this program who wish to have information about it for the purpose of enabling: (i) 

the exchange of information between independently created programs and other programs 

(including this one) and (ii) the mutual use of the information which has been exchanged, should 

contact: 

 

Intellectual Property Dept. for Rational Software 

IBM Corporation 

1 Rogers Street 

Cambridge, Massachusetts 02142 

U.S.A. 

 

Such information may be available, subject to appropriate terms and conditions, including in some 

cases, payment of a fee.   

 

The licensed program described in this document and all licensed material available for it are 

provided by IBM under terms of the IBM Customer Agreement, IBM International Program License 

Agreement or any equivalent agreement between us.   

 

Any performance data contained herein was determined in a controlled environment. Therefore, 

the results obtained in other operating environments may vary significantly. Some measurements 

may have been made on development-level systems and there is no guarantee that these 

measurements will be the same on generally available systems. Furthermore, some 

measurements may have been estimated through extrapolation. Actual results may vary. Users of 

this document should verify the applicable data for their specific environment.   

 

Information concerning non-IBM products was obtained from the suppliers of those products, their 

published announcements or other publicly available sources. IBM has not tested those products 

and cannot confirm the accuracy of performance, compatibility or any other claims related to non-

IBM products.  Questions on the capabilities of non-IBM products should be addressed to the 

suppliers of those products. 

 

This information contains examples of data and reports used in daily business operations. To 

illustrate them as completely as possible, the examples include the names of individuals, 

companies, brands, and products. All of these names are fictitious and any similarity to the names 

and addresses used by an actual business enterprise is entirely coincidental.  If you are viewing 

this information softcopy, the photographs and color illustrations may not appear. 
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Trademarks 
IBM, the IBM logo, ibm.com, DOORS, Passport Advantage, and Rational are trademarks or 

registered trademarks of International Business Machines Corp., registered in many jurisdictions 

worldwide. Other product and service names might be trademarks of IBM or other companies. A 

current list of IBM trademarks is available on the Web at www.ibm.com/legal/copytrade.html. 

 

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel 

Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel 

Corporation or its subsidiaries in the United States and other countries. 

 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation 

in the United States, other countries, or both. 

 

Other company, product or service names may be trademarks or service marks of others. 
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